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This End-User License Agreement (EULA) represents the contractual conditions
between you, the Licensee, and UVI, located 159 rue Amelot, 75011 Paris - France for
the use of software, documentation and other materials created by UVI.

You should not register, install or use UVI Products until the following license
agreement is understood and accepted.

By using UVI Products, or allowing anyone else to do so, you are accepting this
agreement.

A- License Grant
1. UVI grants to you, subject to the following terms and conditions, the non-exclusive
right to use each authorized copy of the Product.

2. UVI Product license are granted only to a single user. You may use this product on
up to three separate computers or iLok Dongles, which shall be owned and used by
you exclusively.

3. Renting or lending the licensed Software to a third party is expressly forbidden.

4. Except if otherwise stated within this EULA, Licensee may resell the software to

a third party or transfer the software permanently. Request may be done using the
‘Transfer License’ feature in your iLok account, subject to a $25 fee per-license ($50
maximum) by Pace. The serial number of the Product will be transferred to the third
party by UVI, and Licensee’s original registration will be deleted.

5. Resale or ownership transfer of individual products obtained in a bundle, or those
used to upgrade or cross-grade to other products are not allowed.

6. UVI allows you to use any of the sounds and samples in the products you've
purchased for commercial recordings without paying any additional license fees or
providing source attribution to UVI.

7. This license expressly forbids resale or other distribution of the sounds and software
included in the Product or their derivatives, either as they exist on disc, reformatted
for use in another digital sampler, or mixed, combined, filtered, resynthesized

or otherwise edited, for use as sounds, multi-sounds, samples, multi-samples,
wavetables, programs or patches in a sampler, microchip or any hardware or software
sample playback device. You cannot sell the Product content or give it away for use by
others in their sampling or sample playback devices.

8. In the event UVI terminates this agreement due to your breach, you agree to return
the original and all other copies of the software and documentation to UVI.

9. UVI reserves all rights not expressly granted to herein.

B- License Activation

1. In order to use UVI Products it is required that you authorize them by registering
your Serial Number on uvi.net/register, have a free iLok account (not necessarily

a dongle) and install the free iLok License Manager (done automatically by UVI
Workstation and Falcon installers). It is impossible to use UVI Products if they are not
registered and authorized.

2. During authorization you will need to enter your name, email address and postal
address which will be stored in the UVI database. UVI uses a secure SSL connection
with 128-bit-encryption that meets current security standards to transmit your data

over the web. For further information about UVI's handling of personal data please see:

https://www.uvi.net/privacy-policy
3. The UVI Product license allows up to 3 simultaneous activations on any combination

of iLok dongles and computers. Activations can be moved between devices at anytime
through the iLok License Manager.

UVI.NET

C- Protection of Software

You agree to take all reasonable steps to protect the Product and any accompanying
documentation from unauthorized copying or use. You agree not to modify the
Product to circumvent any method or means adopted or implemented by UVI to
protect against or discourage the unlicensed use or copying of the Product.

D- Ownership

Ownership of, and title to, the enclosed digitally recorded sounds (including any
copies] are held by UVI.

Copies are provided to you only to enable you to exercise your rights under the
license.

€E- Term

This agreement is effective from the date you open this package, and will remain in
full force until termination. This agreement will terminate if you break any of the terms
or conditions of this agreement. Upon termination you agree to return to UVI all copies
of this product and accompanying documentation and destroy any other copies made.

F- Restrictions

Except as expressly authorized in this agreement, you may not rent, lease, sub-license,
distribute, copy, reproduce, display, modify or timeshare the enclosed Product or
documentation.

G- NFR Serials and Free Products

UVI Products serial numbers labeled as “NFR" (Not For Resale) shall only be used for
demonstration, testing and evaluation purposes. NFR Products may not be used for
commercial purposes, and may not be resold or transferred.

They are not eligible for license recovery and are exempt from update, upgrade

or crossgrade offers, and cannot be purchased with or exchanged for vouchers.
Furthermore, as an owner of an NFR Product, you are not entitled to promotions
available for the commercial version of the Product.

H- No Support Obligation

UVI will make its best effort to support you in the event of technical difficulty with a
UVI Product. However, UVI is not obligated to furnish or make available to you any
additional information, software, technical information, know-how, or support.

I- Specifications and System Requirements

All technical specifications of UVI Products provided are intended to be estimates

or approximations. Due to numerous variables no guarantees of compatibility or
performance can be made. All such specifications shall be in writing.

End-User is solely responsible for, prior to purchase, ensuring that End-User’s devices
are compatible and meet the system requirements for UVI Products, and that the
applicable UVI Products meet End-User’s requirements.

This EULA is governed by the laws of France.

©2017 UVI. All rights reserved.
All trademarks are the property of their respective owners.

A AR AN A A A A AR A N A N AN AR A AN AN A AR A R AN A N AN N AN N N N N A N A N A A N A R A A AN AN N AN A A N AN R N A N AN N A N A A A A R A N AN A A A N A A A A A A A A v 4
AR A AN AN A A A A AN A A A AN N A AN AN AN AN AN A AR AN AN A A A A A N A AN N AN A AN AN A A A A AR A A A A A AR AN AN AN AN AN AN AN A A N AR A A A AN A A AN AN N AN A A R A A A A A a4




UV ey

DSEEIRINII VoLuUME 2 1OQ]

Table of Contents

A A AN AN AN AN A A A A A A A A A N AN AN A AN AN A N AN N A A A A A A A A A A A N A A A A A AN A A A A A A A AN N A AN A N A AN A A A A A A A A N N N A A A A N A A A A A A A A A A A A A A a4

INEFOAUCTION oo b
DZmo
I TACE s 5
PreSet LSt ... 6
DK5S
I TACE s 7
PreSet LISt ... 8
DS-890

L B T @ T e 9

A A AN AN A A A A A A A A A A N N AN AN AN AN AN N N A AN A A A A A A A AN A A N AN AN A AN AR AN AR A A A A A A AN AN A AN AN A AN AN AR AN AR A AN AN A A A AN N A AN N N A N R A A A A a4
AR A AN AN A A A A AN A A A AN N A AN AN AN AN AN A AR AN AN A A A A A N A AN N AN A AN AN A A A A AR A A A A A AR AN AN AN AN AN AN AN A A N AR A A A AN A A AN AN N AN A A R A A A A A a4

UVI.NET




UV ey

DSEEMI UL VoLUME 2 1OQ]

ntroduction

A A AN AN AN AN A A A A A A A A A N AN AN A AN AN A N AN N A A A A A A A A A A A N A A A A A AN A A A A A A A AN N A AN A N A AN A A A A A A A A N N N A A A A N A A A A A A A A A A A A A A a4

Digital Synsations Vol. 2

The late ‘80s and early '90s was a time of great
technological change, ushering in the digital-era and
bringing with it exciting new possibilities. Over the years
a legion of digital synthesizers appeared from all across
the world, reforming the very idea of what a keyboard
could do. Equipped with new and innovative synthesis
techniques, these machines would forever change our
sonic landscape and lay the groundwork for the modern
software instruments and effects that we use today.
Digital Synsations Volume 2 is the next step in our
journey to revisit and preserve these revolutionaries,
exploring the capabilities and unique character of 3
digital synths from the ‘90s.

Minimum System Requirements

e UVI Workstation 2.6.10+ or Falcon 1.2.1+

e 18.25GB of disk space

For more information on the installation process, please refer to
the document: Soundbank Installation Guide
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(oo o @ DZmo i
3 REALTIME TRANSWAVE SOUNCWARE 'L

Amplitude Fitch

Vel = Atk

¥® Bit Crusher
Sterea

Off Altemate  Unisen ViiK Thorus Vibrate Tramolo

) Effects

1 P Mono/Poly 4 B Pitch 7 @ Bit Crusher
Switch between mono and poly voicing » Depth »  Bit Crusher On/Off
Sets the depth of portamento Enable/Disable the Bit Crusher effect
2 D Amplitude » Time » Bit
» ADSR Sets the glide time Set the bit reduction
Typical envelope controls for the amp » Frequency
» Vel > Atk 5 P Drive Set the Bit Crusher sample rate
Remaps Attack to Note Velocity »  On/Off Switch » Drive
» Velocity »  Amount Adjust the overdrive amount of the
Adjust the amp velocity sensistivity Sets the drive amount Bit Crusher effect
3 P Filter 6 P Stereo 8 D Effects
» ADSR » Mode - Off (mono) » Phaser
Typical envelope controls for the filter » Mode - Alt Adjust effect mix amount
» VEL Stereo position alternates L/R every » Delay
Adjust the filter velocity sensitivity note, width controlled by [Width] Adjust effect mix amount
» CUT » Mode - Uni » Reverb
Filter cutoff frequency Layers multiple samples and augments Adjust effect mix amount
» RES them for increased stereo presence
Filter resonance amount » Color 9 P Modwheel
» ENV Utilizes neighboring samples from the » Power/Amount
Depth of the filter envelope library to a unique effect Easily route your controllers Modwheel
»  Filter Type » Spread to control common parameters such as
Multimode filter can be set to low-pass Sets the stereo width (ALT mode) Vibrato, Tremolo and Filter Depth
(LP), band-pass (BP), or high-pass [HP] » Detune

Detunes the unison layers (UNI mode]
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Bass FX-Weird Pads Sweeps Vocals-Formant
Agni Maya AN Bi Portamento Bubble Gum Aurora AN Analog Mood
alo Bass AN Drunk THX Clearnet X Bass and Sweep Choir Formant
Calvin Bass Evolutione Crystal Storm Casus Belly D50 Vox Like
Fatable One Fizmotron Digital Pad Digital Sweep Digital Kortex
Funkzmo 1 FXmo Explorer AN Fantasmogorix Doozmo 1
Funkzmo 2 Little Zap Fifth Dimension Lead Sweep Doozmo 2
Funkzmo 3 Transwave Beach Galactipad Sport Sweep Formant Keys
Mini Lazer Harp Wind Transfert LFO Mont Sweep Table 1 Hybrid Vox 1
Modularperc Mirage AN Sweep Table 2 Hybrid Vox 2
Organ Bass Keyboards Mutable Waves Swhithles Inclassablvox
Polykeys Bass Cindy Lau Peach Pad Transphonic Narrow Fields
Roombass Clavisonic Saint Petersbourg Phonemoid
Round Up FizmOrgan So Padizmo Tempo Synced Pluck In
Saw Bass Tea Giorgo Lamani Soft Transpad Active Step Scream Pad
Square Face JazzMOrgan Sporting Pad Agotra AN Sporting Voices
Warmer Movie Show Keys Chaos Sporting Sweep Formant
Weirdo Bass Muktivada AN Polysynth Deepology AN

Polykeys Bi Polysynth EFX Arena AN

Bells PulsoClavo Dirty Five Guimberlum
Clearnet X Bells Soft Mood Keys Keysoft Pix Moving Pad
Dark Mood Space B3 Phatzmo Moving Stack
Fizmabell Transwave Keys Poly Artifact Paramatrix
JazzMBell Wurlizmo Poly Sporting ParaPadrix
LFO Montbello Soft Fizme Pulsar AN
Musoc Bix Leads Stax Nalog Pulsar Solo
Pacques Beau alLo Solo Realtime Waves
Space B3ells Analozmo Seq Soft Wooble AN
Sporting Bell Fatablead Arbalette Spacial Lounge
Standard Bell Formant Solo Fifth Seq Transmutable
Transwave Bell 1 Funkzmo Lead Mellow Seq Voxus Belly
Transwave Bell 2 Inclassablead Modular Short Voxus Soli
Transwave Bell Keys Lead Artifact Seq Vox

Pulsolo Soft Corn

Brass Pure Translead Square Short
Brass Analozmo Roomsolo
Fiz Brass Saw Sai Tea Strings
Funk 80s Scream Vox Agni Klana AN
HyBrassid Soft Translead Fizmicato
Limit Five Solo Brassizmo Interfizmo
Movie Brass Solo Maya Movie BrasStrings
So Brassizmo Phatzmood
Soft Table Pure Transtring
Sporting Horns Sad Analog
Sweep B String Max In
Transbrass Thin Digital

Transominous Waves
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DKS5S - Interface
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Porecs
) Modwheel

Pseres
48 Mono / Poly

Amplitude @4

EET

74 Bit Crusher

1 P Mono/Poly 4 B Pitch 7 @ Bit Crusher
Switch between mono and poly voicing » Depth »  Bit Crusher On/Off
Sets the depth of portamento Enable/Disable the Bit Crusher effect
2 D Amplitude » Time » Bit
» ADSR Sets the glide time Set the bit reduction
Typical envelope controls for the amp » Frequency
» Vel > Atk 5 P Drive Set the Bit Crusher sample rate
Remaps Attack to Note Velocity »  On/Off Switch » Drive
» Velocity »  Amount Adjust the overdrive amount of the
Adjust the amp velocity sensistivity Sets the drive amount Bit Crusher effect
3 P Filter 6 P Stereo 8 D Effects
» ADSR » Mode - Off (mono) » Phaser
Typical envelope controls for the filter » Mode - Alt Adjust effect mix amount
» VEL Stereo position alternates L/R every » Delay
Adjust the filter velocity sensitivity note, width controlled by [Width] Adjust effect mix amount
» CUT » Mode - Uni » Reverb
Filter cutoff frequency Layers multiple samples and augments Adjust effect mix amount
» RES them for increased stereo presence
Filter resonance amount » Color 9 P Modwheel
» ENV Utilizes neighboring samples from the » Power/Amount
Depth of the filter envelope library to a unique effect Easily route your controllers Modwheel
»  Filter Type » Spread to control common parameters such as
Multimode filter can be set to low-pass Sets the stereo width (ALT mode) Vibrato, Tremolo and Filter Depth
(LP), band-pass (BP), or high-pass [HP] » Detune

Detunes the unison layers (UNI mode]
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DK5S - Preset List

Bass
Acid Box
Bottle Bass
Classic Analog
ClicSub 1
Clic Sub 2
Clic Sub 3
Filter K
Funky Like
Gorilla
House Club
Micro TB
Phat Grain
Pop Funk
Power Town
Subcon
Syncrhotron
Taurusing
Tubadditive
X Clubass
Zapp Mood

Bells
Basicell
Breathing Bells
Clickopolis
Fantasiak
Feerique
High Liasing
Hybrid Jazz Bells
JD Elec Piano Bell
Knalog Bells
Mat Swing
Monte Christo
Road Tines
Sine B
So Eighties
Talking Bell
Think Glass
Tubel Air
Ultra Soft Digit
Vox Bell

UVI.NET

Brass
Car 5000
Cosmo Brasses
Frenchy Horn
Ghost Brasser
Mixed Brassy
Movin Brass
Obie 5K
Prophet 5K
Sax Additive
Synth Brass 1
Synth Brass 2
Van Allen
Xilhornphone

FX-Weird
Cyber Mosquito
Digital Jungle
ice Land
In Da Space
Marry Poppins
Multi FX
Sixth Dimension
Underground

Keyboards
Additive Tines
Dirty Darkeys
DKlavinet
DX Guitines
Dyno Vibes
FM Tiny
Harpsy Dre
JD Elec Piano
K5lavinet
Melancolikeys
Modern EP
Numerhodes
Piananalog
Steady Road
Suitcase Ditive
Super Pmart
Synth Keys
Toys Add Piano
Wurly DKS 1
Wurly DKS 2

DS RIS {HYINE voLumME 2

Leads
Bottle Lead
FeedBackin
Lead Clic Sub
Micro TB Lead
Nicolead
Picky Lead
Subcon Lead
Supra Funky
Synchrotron Lead
Taurusing Lead
Wah Solo

Organs
Charlie Oled
Clear Organ
Full Space Organ
Happy Days
Hybrid Jazz
Mellorgan
Organ House 1
Organ House 2
Organ Vib
Orgatack
Process B3
Pure Ham 1
Pure Ham 2

Pads
Basic Padd
Calm Field
Composite Bed
Deep Field
Fantasiadditive
Jun Orange
Layer Bright
Mad O Five
Mini Overture
Movin Pad
Orbital Fluid
Pad Glass
Sine B Portapad
Verseau

Pluck
Cold Pluck
Crystal Guitar
Dulce Major
Flutata
Fretted Space
Generation X
Gorilla Frets
Hard Mute Guit
Hardmonix
Hybrid Pluck
K5oto
Little Slap
PCorn Acid Box
Pluck Vox
Resistance
Retro Phasing
Softy Plucky
Stack Atoh
Steam Reso
Steel Detuned
Stratadditive

Polysynth
Cyber Flute
Dirty Stack
Eurotek
Five Stars
Lauper Synth
Magic Flute
Modularium
Polysynth K5S
Ravage
Rave Party
Raw Saw
Soft Poly
Space Metal
Sweepoly
The Snake
Zapp Poly Mood
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Strings

Claustrochestra
Dark Ensemble
Electro Strings
Four Pieces

Left and Right
Modularium Cordes
OB Strings
Simple Wave
Space Orchestra
Synth Strings
Very Soft Strings

Sweeps

Add Glasssweep
Frequency Browser
Gentel Lay
Heartificial
Multipolaire
Reversweep

Vocals

Dark Space 1
Dark Space 2
Fair Pad

Full Light
Mello Space
Moon Chorale
Pizzi Voices
Porta Vox 1
Porta Vox 2
So 90s
Stackoirs
Synthetic Motion
Vocabass
Vox Bell Pad
Xylo Voices
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DIGITAL BOU

Amplitude §r4

[ Fiter @ =

EETT

OFF ALT UNI

AMPLITUDE

TREM

18 Mono / Poly

Dorve
7 Bit Crusher

) Modwheel

FILTER

Pore:

1 P Mode 4 » Pitch 7  Bit Crusher
Switch between mono and poly voicing » Depth »  Bit Crusher On/Off
Sets the depth of portamento Enable/Disable the Bit Crusher effect
2 D Amplitude » Time » Bit
» ADSR Sets the glide time Set the bit reduction
Typical envelope controls for the amp » Frequency
» Vel > Atk 5 @ Drive Set the Bit Crusher sample rate
Remaps Attack to Note Velocity »  On/Off Switch » Drive
» Velocity »  Amount Adjust the overdrive amount of the
Adjust the amp velocity sensistivity Sets the drive amount Bit Crusher effect
3 D Filter 6 B Stereo 8 P Effects
» ADSR » Mode - Off (mono) » Phaser
Typical envelope controls for the filter » Mode - Alt Adjust effect mix amount
» VEL Stereo position alternates L/R every » Delay
Adjust the filter velocity sensitivity note, width controlled by [Width] Adjust effect mix amount
» CUT » Mode - Uni » Reverb
Filter cutoff frequency Layers multiple samples and augments Adjust effect mix amount
» RES them for increased stereo presence
Filter resonance amount » Color 9 P Modwheel
» ENV Utilizes neighboring samples from the » Power/Amount

Depth of the filter envelope

»  Filter Type
Multimode filter can be set to low-pass
(LP), band-pass (BP), or high-pass [HP]

UVI.NET

»

»

library to a unique effect

Spread

Sets the stereo width (ALT mode)
Detune

Detunes the unison layers (UNI mode]

Easily route your controllers Modwheel
to control common parameters such as
Vibrato, Tremolo and Filter Depth
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A A AN AN AN AN A A A A A A A A A N AN AN A AN AN A N AN N A A A A A A A A A A A N A A A A A AN A A A A A A A AN N A AN A N A AN A A A A A A A A N N N A A A A N A A A A A A A A A A A A A A a4

Bass Brass Leads Pluck Strings Vocals
Extravaganza Amex Brass 890 Lead 1 Africa Yanni Aqueous Strings Ample Fair
Funk Wah Cool Analog Horns 890 Lead 2 Clean Mallet Full Orchesta Attack Fair
Funk Wah Hard Brass Atitude Analog Solo Dulci Madre Instable Strings Beauty Vox
Garage Bass Brass Matic Big Five Guitar Scream JD Sole INA Bella Choir
JBBass Dry Brass Dry Lead Hypra Melody Large Strings Cloudosphere
JD Bass 1 Embouchure Flutty Solo Mall Street Little Solina Cymbalo Pad
JD Bass 2 Golden Sands Funk Wah Lead Movin Harp Magic Orchestra DFifty Cents
JD Bass 3 Jedi Brass 1 Funky Rose New Age Lead More Than Large Fairmont Hotel
Neon Bass Jedi Brass 2 JD Solo Two Pizz Voices Ouverture JairDlight
OBassheim Jedi Brass 3 Screaming Lead Pizza Stack Pure Analog JD Light Fair
Pizz DBass Large Syn Brass Slap Man Lead Scream Guitar Smooth Cordes Key Vox
RoomBasstic Majesty Brass Stack Solo Soft Harp Solinex Munichoir
Slap Man Mello Dark Synchonanbourg Syn Scream Stack Orchestra Phasor Winds
Stack Bass Pure OB Ultra Pluck Strings Of Jedi PNL Voices
Straight Bass Revenge Helis Valise Sehr Soft
Ultra Bass Stack Brass Clould NL Polysynth Sweeps Smooth Choir
VerBass Wind Brass Coton De Soie Analopoly Air Sweep Vox Affair

Demoniak Disto One Elephantus Voxhimer
Keyboards Evapore Doctor Dro Mandala Sound Voxynth

890 Bell 1 Acoustic Piano Evolving Euro Rythmic Mellow Sweep Windy Vox
890 Bell 2 Big Church FX Pad Hardcore Poly Smoothies
890 Bell 3 Broken Piano Glass Vox Philadelphia Stack Sweepad
ComplexBells Diganalog Linear Pad Power Poly Sweep Keys
Cryptonic Bells Dr Miles Long Island Pad Stack Poly Thorusing
Epic Bells Dream Road Macro Pad Stellar Mello Ultra Fat Sweep
JDX Bells Dream Tines Meditation Syn Poly 1 Vox Belly
Long Island Bells Electronic One Nimbus Syn Poly 2 Whispering
Loon Ease GospOrgan Octave Pad Ultra Fat
Macro Bells Jazz Oganic Ominous Fair
Muystic Bells 1 JD Clavinet Organix Seq
Muystic Bells 2 Judi Wurli Pluck Pad JD Seq Three
Process Bells 0Old Rgan Randomish Pad Large Pop Corn
Steel Drumy Piano Sympathi Space Flute Mini Mallet

Power Piano Stress Pad Perco Sine

Room Clav Tron Winds Short Keys

TechnoKeys Up To Pad Very Shorty

Vintage Ac Piano Vox Bax
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Home . . o uvi.net/ &

Soundbank Installation Guide . . . . . . . ... installing_uvi_soundbanks_en.pdf &&
UVI Workstation User Guide . . . . . . . . . ... uviworkstation_user_guide_en.pdf &
Your Registered Product Serial Numbers and Download Links. . . . . .. .. uvi.net/my-products &

FAQ . uvi.net/fag &

Tutorialand Demo Videos . . . . . . . . .. youtube.com/&&

SUPPOrt . . . uvi.net/contact-support &&

Home . . . . ilok.com/ &
iLok License Manager . . . . . . .. ... ilok.com/ilm.html &
FAQ . ilok.com/supportfag &
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http://www.uvi.net/
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/installing_uvi_soundbanks_en.pdf
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/dwl.php?p=doc-en
http://www.uvi.net/my-products
http://www.uvi.net/faq
https://www.youtube.com/user/UVIofficial
http://www.uvi.net/contact-support
http://www.ilok.com/
https://www.ilok.com/#!license-manager
https://www.ilok.com/#!faq
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